TABLE OF CONTENTS

Learning through an Example – Creating the 090 Report

Purpose of this Guide .................................................................................................................. 4

Introduction ................................................................................................................................. 5

What Is eThority? ......................................................................................................................... 5

Why eThority? .............................................................................................................................. 5

System Requirements ................................................................................................................. 5

Glossary ........................................................................................................................................ 6

eThority Basics .......................................................................................................................... 7

Logging In .................................................................................................................................... 7

Navigation / General User Interface ......................................................................................... 8

Moving Windows ....................................................................................................................... 9

Resizing Windows (Closing, Minimizing, Resizing & Maximizing) ........................................... 10

Restoring Windows .................................................................................................................. 12

Changing the Display Method .................................................................................................. 13

Refreshing the Window ............................................................................................................. 15

Searching for Databooks .......................................................................................................... 15

Learning Through an Example – Creating the 090 Report ....................................................... 16

Logging Into eThority ................................................................................................................ 17

Collapsing and Expanding Views .............................................................................................. 18

Global Derived Databooks ........................................................................................................ 19

Grouping / Sorting / Filtering... An Overview ......................................................................... 21

Selecting & Removing Fields in a Report .................................................................................. 21

Saving a Report ......................................................................................................................... 26

Filtering ..................................................................................................................................... 28

Grouping .................................................................................................................................... 32

Sorting ....................................................................................................................................... 36

Powerfields ............................................................................................................................... 38

Creating a Powerfield For a Specified Condition .................................................................. 39

Creating a Powerfield – Calculated Field ............................................................................... 48

Creating a Powerfield – Concatenated Field ......................................................................... 53

Substitution Powerfields .......................................................................................................... 56

Renaming and Rearranging Fields in a Report ........................................................................ 60

Last Updated: July 9, 2012
Purpose of this Guide

This guide gives you a general overview on how to use eThority, the reporting tool that will be used in conjunction with the Kuali Financial System implementation at UH. It covers the basic functions that the tool offers as well as provides a working example to help re-enforce understanding.

One of the best ways to learn how to do things is to relate it to something you’re familiar with. This guide will walk through the process of creating a report that’s very similar to the FBMR090 report. While the end result is very similar to the 090 report, this guide takes some liberties in the creation of some of the fields just to demonstrate concepts in eThority. The reporting team advises users to use the actual 090 templates built rather than relying on the procedure in this guide.
Introduction

What Is eThority?
eThority is a business intelligence analytical tool that helps the user get more out of their data. Through its web based interface, users have the ability to slice and dice their data using a graphical drag and drop interface. eThority supports exporting to standard formats such as Excel, text, XML and PDF.

Users can create graphs, charts and pivot tables with their data through the interface. While it does give users access to data, it is not a reporting tool. Hence, the tool does not allow for users to produce highly formatted and styled reports. Instead, eThority generates what they term databooks. The end result of a databook resembles something comparable to what the FMIS Datamart produced which is very similar to a spreadsheet.

Why eThority?
Kuali out of the box does not come with standard financial reports. eThority was chosen by the University as the tool that will enable users to analyze their financial data for planning, decision making and reporting purposes.

The concept behind eThority is to empower the users to shape their data based on structures designed by the reporting team. Users are not allowed to modify any of the underlying data or combine dissimilar data which would produce unexpected results.

With the ability to shape comes the flexibility for the users to create reports for their own specific needs. Users can also share reports with others in the event a databook becomes useful to a larger user base. This saves development time and can reduce duplicated effort.

System Requirements
Since eThority is a web based application the system requirements are relatively minimal. You will need a browser that is capable of handling Flash. i.e. eThority does not work with Apple ‘i’ products such as iPad and iPhone, since they are not Flash compatible. The reporting team recommends using the latest versions of Firefox or Chrome. Internet Explorer does work if it’s version 9 or later.

For exporting, you will need Adobe Reader for PDF documents and Excel (or compatible viewer) for Excel documents. You will also need to enable popups for the eThority site as print jobs and exports use popups to send the files.
Glossary
Like any other application, eThority has its own lingo. Here are some of the terms that are mentioned throughout the guide.

Data Architect – also referred to as the reporting team. Data architects create the global derived databooks and are responsible for the back end data structures that drive the eThority databooks. They also control the user security and permissions.

Data Explorer – User role that allows for the creation and viewing of databooks. These users can use existing databooks and create their own as needed.

Data Viewer – User role that only allows for viewing of existing databooks.

Databook – A shaping of data that represents a report.

Root Databook – The basic building block of a databook. Contains the fields relating to a specific type of data from which other databooks can be created. These are only created by the data architects.

Derived Databook – Databook that is based off of a root databook. These databooks have additional shaping that is specific to that databook.

Global Databooks – Databook type that allows any user to access its contents. Users with the appropriate rights can create their own derived databooks.

User Databooks – Databook type that is only viewable by the user that created it, or if the databook was explicitly shared with that user.

Powerfield – a user created custom expression/calculation that is used in a report.

Control value – a parameter specified in a databook that prompts users for values for use in a report.

Dashboard – a collection of various databooks that are consolidated in a single window view. Allows the users to see a set of reports all at once rather than having to open them individually. Useful to show things at a quick glance.
eThority Basics

Logging In

Once you navigate to the eThority website, it will present you with a login page.

![Login Page]

For your username, you will need to provide your fully qualified UH login (i.e. username@hawaii.edu). Enter your password in the password box, then hit Login.

The Reset Password option will send you an email to your UH email address that you provide. Click on the link in the email then change your password to what you want it to be.
Navigation / General User Interface
The general interface of eThority is similar to that of a standard application on most computers. There are a series of menu options on the top and a series of windowed panels. Each window groups related functionality together and makes finding things in the system easier. The interface is somewhat customizable such that a user can arrange the windows in the layout of their choosing.

![Default Layout](image)

*Figure 2: Default Layout*
Moving Windows
The eThority user interface uses window panels to group related items together. Each of the panels can be resized and moved as the user desires similar to how you would move windows on your computer. To move a window, just click on the title area and drag the window to where you want it to be.
Resizing Windows (Closing, Minimizing, Resizing & Maximizing)
On each panel there’s a set of three circular buttons that will close, minimize and maximize (respectively) the window. The minimize button also serves as a return to default position button if the window was moved from its default position.

![Close, Minimize, Maximize buttons](image)

*Figure 4: Close, Minimize, Maximize buttons*

If the minimize button is selected again, the window is minimized to just show its title.

![Minimized Windows](image)

*Figure 5: Minimized Windows*
Notice in Figure 5 there are green diagonal lines on the bottom right of the window. Clicking there and dragging inward or outward will change the cursor into a two sided diagonal arrow. This indicates you can stretch the size of that window.

Figure 6: Resizing a Window
Restoring Windows
In the event you close windows, to get them back, use the Window menu to select the specific window you want to open, or select a workspace to have several windows restored at once.

Selecting the options on the Window menu just brings back the window that is selected (Databooks, Dashboards, Message Center, Search Results, Configure, Favorites)

Workspace options restore sets of windows in specific defaulted locations. Basic is the default settings that users are given. The other options rearrange the windows to put certain windows in view more than others.

Users are free to select whichever window scheme they choose. User selections should retain once selected such that you don’t need to select it each time you log in.
Changing the Display Method
Within a window you can change the way eThority displays the contents of a window. Clicking on the following button will toggle between a list view and a graphic view.

![Figure 9: Display Toggle](image)

On the Databook window, you can further customize the views by clicking on the tab shown below:

![Figure 10: Window Display Options](image)

There are four options that are presented when that icon is clicked.

Show Data in List Mode is the first icon, which shows the Databook window’s contents in a table view like a spreadsheet.

![Figure 11: Show Data in List Mode](image)
Show Data in Tree Mode is the default view which shows the Databook window in a hierarchical folder structure.

The last two buttons work in Tree view only and they collapse and expand the tree hierarchy. This saves the user from having to click open/close each folder – the option opens/closes all of the sections one level at a time. Figure 13 shows what the collapsed view looks like. Figure 12 shows one level of expansion.
Refreshing the Window
Since eThority is a webbased application that operates in your web browser, not all of your updates take effect immediately. In the case of creating/saving a new report, you may be surprised to not see it in the listing. Instinct would tell you to hit the refresh button on your web browser, but this will actually kick you out of the system and require you to log back in. Instead click on the icon near the Help menu in eThority.

![eThority's Refresh Button](image1)

Searching for Databooks
The search function in eThority allows you to search for databooks that have been created.

![Search field](image2)

Currently the search field searches the report name and description fields.

![Search Results](image3)
Learning Through an Example – Creating the 090 Report

One of the best ways to learn how to do things is to relate it to something you’re familiar with. The following section will walk you through the process of creating your own databook in the format of the 090 report. The primary purpose of the example is to get you familiar with eThority’s functionalities. While the report does appear similar to the actual 090, some liberties were taken to demonstrate functions. As such, the output of what is designed in this example will not match what the actual 090 report that the reporting team has created.
Logging Into eThority
Log into the eThority site by going to the following address:
ethority.reports.hawaii.edu

Your browser should then present the login page to eThority

Note that the address bar may have changed slightly. As long as the beginning part of the address reads https://ethority.reports.hawaii.edu you’re at the right place.

- Enter your username and password. Your username is your fully qualified UH email address (for example: username@hawaii.edu) Your default password is Kual1! The password is case sensitive.
- Once you have successfully logged in, you should see a screen similar to the following:
Collapsing and Expanding Views
To make the display more manageable and able to find the area we’ll be working with, use the collapse tool to reduce the list down to the major areas.

Click on that button until the listing looks similar to the following:

Notice that the listing is a lot shorter.
Global Derived Databooks
Click on the plus sign next to the KFS GL Databooks folder to expand that section. Your display should look similar to the following:

Within the folder you will see icons that look like a book with a blue globe on them. These are what eThority calls “Global Derived Databooks”.

These are created by the eThority data architects as your starting point for your reports. Each one of these global derived databooks has the fields/attributes you can use for your reports. If you do not see a field in the field selector in this databook, the field/attribute is not available for reporting.
For this exercise we’ll be using the GL Financial Transactions – Template global derived databook. To use it, double click on the name of the databook which should open the report builder in a new browser window.

The report builder window should look similar to the one shown below:
Grouping / Sorting / Filtering... An Overview

As a review, the top portion of the report header does the following tasks:

Grouping allows you to group similar information together, as well as to do summarization function such as totals and averages. In eThority, grouping also implies sorting, so you don’t have to group and sort a field.

Sorting allows you to order the report by the specified data field. You can specify multiple sorting criteria, and eThority will process them in a top to bottom order.

Filtering is your restrictive condition or limits on your report. For example, in this area you can specify to just have eThority return transactions for a specific FO or account number.

Selecting & Removing Fields in a Report

Now, let’s get started in creating a report. We recommend that you first remove all of the fields from the template and select only the fields that you would need to create a report.

To do this, go to the View menu, then select Field Selector.
This should bring up a window similar to the one shown below. Click on the Remove All button near the bottom right of the window.

After clicking on the button, your screen should look like the following:
Now, we’re ready to select the fields that we will need to create the report. By default, the fields are in order of how the global derived databook was built. To make finding the field you want easier, you can sort the list of fields alphabetically by clicking on the Column Name header under the Available Fields area.

To select a field, you can either double click on the field you want, or select the field, then click on the Add Field button. Now that your available field listing is sorted, select the following fields:

- University Fiscal Year
- Fiscal Period Code
- Basic Accounting Category Code
- FO Code
- Account Number
- Budget Summary 1 Code-Name
- Object Code-Name
- Actual Amount
Once you have selected the fields, your screen should look similar to the following:

![Image of the EThority database selection interface]

You might notice on the Available Fields side of the screen that some field names are listed as bolded green text. These fields have already been selected into your databook. The non-bolded ones are fields that are available for you to select to use.

Click OK once you’re satisfied with what you selected. Your screen will change and you will see a watermark going across the report area that says “Refresh needed”.

![Image showing the watermark “Refresh needed”]

---

Last Updated: July 9, 2012

Page 24 of 85
Clicking the refresh button will update the report to just include what you selected on the field selector screen.

Technically, you’ve now created a report. It just has what you selected and presents them in the order that they were selected... but it still doesn’t look like the 090 report.
Saving a Report

Before continuing further, you should save your work (you should save periodically). To save your report, go to File, then select Save as. (the users won’t see the the save option.. need to go into an account that isn’t a DA account.)

This will then bring up a screen similar to the following:

The Name field specifies what the report will be called. You can enter a more descriptive explanation of your report in the Descr field. Both of these fields are displayed in the report listing. The other options on the screen are beyond the scope of the document at this time, so enter a report name and a description, then click on OK.
NOTE: Please be wary of the Prevent Overwrite flag on the Save & Save As screens. When this option is selected, it will prevent you from overwriting the existing databook. This means that you won’t be able to save the changes you make to it; you will be forced to do a Save As.

The Prevent Overwrite flag is useful for when you want to ensure you don’t inadvertently change your databook. It also is useful for when a databook is shared with other users, so that they can’t save over your existing databook.

If you see that this option is selected when you attempt to do a save as, please uncheck this option prior to doing the save operation. This will allow you to make changes to the copy that you are saving. If you leave the option checked, you will not be able to make changes to the databook you had just saved – you will be forced to always do a save as.

Once you have made the desired changes to the databook, you can then turn the flag back on to prevent changes from being made to the document without doing a Save As.
Filtering

By default, your report will bring back all records. To limit your report to something more specific, we use the Filter area of the report builder. To create a filter, click on the funnel icon or on the word filter itself.

This should make the Filter Records window appear.
Let’s create a filter that will only bring back the transactions for a specific FO. To do this, find the FO Code field in the field listing to the left of the Filter Records window. TIP: You can sort the listing by clicking on the Column Name header to sort the listing alphabetically. Either click and drag the field name into the area on the right, or just double click on the field name “FO Code”.
Once you have selected the field you want your filter based on, it will bring up the Filter Builder. Here you can specify what value you want to limit your report against.

For this exercise, we’ll use the User Value option to specify the filter values. Click on the circle next to the User Value label to change the way we specify the filter.
In the value box, type in the 3 digit FO Code of your FO. Then click on OK. The screen should update to the following:

After clicking on Close, you’ll be prompted to Refresh again.

Click on the Refresh button to see your report now filtered just for your FO Code.
Grouping allows you to put similar data together for summary and ease of reading. A common attribute things are grouped on is the Budget Summary levels for object codes. The Budget Summary 1 Code-Name field that you selected serves this purpose. This particular attribute has the following possible values:

- NB-Not Budgeted
- A000-Revenues
- B020-Personnel Expense
- B040-Other Current Expense

For this exercise, we'll be grouping the report by this field to make it similar to how the FBMR090 reports were displayed in FMIS. To create a group, click on the Group icon.
Creating a grouping is similar to creating a filter. You can click and drag the field that you want to group by from the listing on the left, or you can just double click on the field name. Find the Budget Summary 1 Code-Name field, then select it for grouping.

Click on OK, then click Refresh to update the report to see your newly created grouping.
You may notice there’s a plus symbol next to each item. Clicking on it shows the details that make up each grouping.

The listing we created would probably be more useful if it were grouped first by account rather than just the budget categories. To add in another grouping, repeat the process that you did for the first grouping but this time, select the Account Number field.
But this isn’t in the order we want it grouped. To change the order, click and drag the Account Number so that it goes above the Budget Summary 1 Code-Name field. Your result should look similar to the following:

Click on close, then click on Refresh. Your report should now be grouped first by account number, then by the budget summary code.
Sorting

Now if you look at the details of your report, you might notice that the fiscal period code seems to be in a haphazard order. To make it always sort numerically, we can use the Sort function of the report builder. Click on the Sort icon to bring up the window to do your sorting.

Specifying which field to sort by is similar to the way it was done for a filter or a group. Find the Fiscal Period Code field in the field selector, then drag it to the right, or double click on the name.

Once you click Close, then Refresh, your report should now be sorted by fiscal period code.
<table>
<thead>
<tr>
<th>Account Number</th>
<th>Budget Summary</th>
<th>Code Name</th>
<th>Fiscal Year</th>
<th>Budgeted Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>1000252</td>
<td>8840-Other Current Ex</td>
<td>10</td>
<td>DX</td>
<td>$100.00</td>
</tr>
<tr>
<td>1000260</td>
<td>8840-Other Current Ex</td>
<td>10</td>
<td>AS</td>
<td>-100.00</td>
</tr>
<tr>
<td>1000262</td>
<td>8840-Other Current Ex</td>
<td>10</td>
<td>AX</td>
<td>$15.00</td>
</tr>
</tbody>
</table>

**Account Number: 1000901**
- **Budget Summary**: 8810-Personnel Payroll
- **Code Name**: 10
- **Fiscal Year**: DX
- **Budgeted Amount**: $10.00

---

Last Updated: July 9, 2012
Powerfields

Right now you have a pretty decent report. It lists all the accounts and transactions sorted by fiscal period for your FO code. But still it doesn’t look like the 090 reports. It doesn’t have the column totals for beginning balance, fiscal year to date, encumbrances and remaining balance.

In order to do this in eThority, we need to use a function called Powerfields. Powerfields allow you to transform existing data in your report into something else. For example, you can take the Actual Amount column and use it to create the Beginning Balance column. Powerfields also allow you to do calculations on other fields, which is what we’ll do for the Remaining Balance column.

To create a Powerfield, click on the Powerfield menu, then select edit Powerfields.
This will bring up the Edit Powerfield window... Click on the Add button to create a Powerfield.

Creating a Powerfield For a Specified Condition
For this Powerfield we’re going to select the eXpression powerfield type.
The first Powerfield we’ll create is the one for Beginning Balance. To get a column that has the amounts for the beginning balance, we’ll need the transactions that are in the Current Budget Amount column for the fiscal periods that have passed so far. Assume that we’re creating this report in the month of May, thus we’ll need to return data for fiscal periods less than or equal to 11.

All Powerfields require a name and a data type. The name of the Powerfield should be unique so that it’s identifiable. A data type is what kind of data that the Powerfield will hold. Examples of valid data types include Currency (money values), Integer (whole numbers), String (text), etc.
In this case, type in Beginning Balance in the Field Name box, then select the Currency data type.

Since we’re basing the value of this field off the Current Budget Amount column, click on the Edit button under the Use this Expression heading.
Select the Current Budget Amount column from the field selector, then press OK.

Next we’ll need to have the Powerfield just return the Current Budget Amounts for all fiscal periods through May. Click on the Edit button under the For these Records heading.
A condition builder that looks similar to the one that appears for a filter will appear. Select the Fiscal Period Code field. Then in the filter builder, select all of the fiscal periods from 0 through 11.

Then click OK on each of the respective windows. You should have a screen similar to the one below.
The above Powerfield will make a column that has the Current Budget Amounts for Fiscal Periods 0 through 11. For transactions that are not in the fiscal periods 0 through 11, the column will display $0.00.
Once the screen looks like the one shown above, click on the Test button. You must click on this button prior to saving or creating another Powerfield. If everything goes successfully, you should get a confirmation message.

From here, click on OK, then you can click on Save. Then click on OK again to go back to your report.

Let’s do another Powerfield for a Fiscal Year to Date (FYTD) column. This column will display the amount for the entire Fiscal Year. Let’s assume that this report is being run in the month of May (which is fiscal period 11).
The process is similar to the Beginning Balance column. Start by going to the Powerfield menu, then select Edit Powerfields. Click on Add, and complete the Powerfield Builder screen until you get a display that resembles the following:

The above Powerfield would give you the Actual Amount for the Fiscal Year through Fiscal Period 11 (May). You can adjust the filter to do the FYTD calculation to a different month, just change the ending digit of the above condition. i.e. for FYTD through March, the above would be Fiscal Period Code between 01 and 09.

Once your screen looks like the one shown above, click on Test, then click on OK after the confirmation message.
See if you can create the Current Month column on your own. Your PowerField window should look similar to the following... remember we’re making this report for the month of May (fiscal period 11):
When you are returned to your main report window, hit refresh to update your report. At the ending of the report you should see two new columns that are shaded yellow. These are your powerfield columns.

Creating a Powerfield – Calculated Field
Another column that is required for the 090 is the encumbrance amount column. This example will show you that you can create a powerfield using a field that’s in your available field listing but not being displayed in your report. It will also show you that you can have a column that is based off of a calculation rather than just a single field.

KFS has several encumbrance buckets: internal, external, costshare and preencumbrance type encumbrances. Because encumbrances could fall into any one of them, we’ll create a powerfield that combines them together into one field.

The process starts the same as the other powerfields done so far. Click on the Powerfield menu, then select Edit Powerfields, then Click on Add, then select the Expression Powerfield type. Create a powerfield with the name Encumbrances with a data type of Currency, then click on the Edit button under Use this Expression.
In the Expression builder that appears, you’ll be adding the four different fields corresponding to the encumbrance amounts, then clicking on the Add button as indicated below.
Once you have selected the field, click on add, then repeat the process for each of the encumbrance fields. When done, your screen should look similar to the following:

Notice there is a plus sign between each of the fields. Since the values are numeric, eThority will add these numbers together. If you were to click the plus sign, you would see the symbols for subtraction, multiplication and division. Once your screen looks like the above, click on OK.
Next, you will need to specify a condition for this powerfield since you would only want the encumbrances that are valid for the current month. Since we’re doing this report for May, create the condition so that your screen looks like the following:

![PowerField Expression Screen](image)

Click on Test, then click on save.
Before closing out this screen, create another Powerfield for the Remaining Balance column. As a hint, your expression builder (the left side of the powerfield screen) should look like the following:
And your Powerfield window should look like the following

Notice that on the right side of the screen under For these Records, there is no condition specified and it says “ALL records”. This means the calculation on the left will be performed on every line. Since this is what we want, click on Test, then OK.

Creating a Powerfield – Concatenated Field
Powerfields can also be used to do concatenations of text fields. Similar to how you can add numeric fields together, concatenating fields is basically “adding” text fields together. For this example we’ll be combining the Account Number with the Account Name to produce a field with the format similar to “2266622 – TFSF Account”
The process starts the same as every other Powerfield. Create an expression Powerfield and call it Account PF, with a data type of String.

To add in the dash between the Account Number and Account Name, you do this by specifying a Custom Value in the User Values area of the screen. Then click on Add.

In this example, it might not be as straight forward as one would expect. In order to create a powerfield that has a concatenation of fields with a space between them, eThority requires you to do something special. You need to create a separate custom value for the space, then another custom value for the dash, then another custom value for the next space. eThority’s program automatically drops leading and trailing spaces from all custom values, and therefore this is the only way around this at present.
Once you add those custom values and the Account Name field, your screen should look like the following.
You want this to appear for all records, so just click on the Test button, then Save your Powerfield. After refreshing your report, it should look similar to the following:

![Screenshot of report](image)

Notice your Account PF column has the account number, a space, then a dash, then another space, then the account title.

**Substitution Powerfields**

There’s another Powerfield type that you may find useful. This is the substitution powerfield. Substitution powerfields allow you to replace an existing value in a data field with some other data. An example of how it can be used is to replace the Fiscal Period Code with the actual month name that it represents.
Click on the Powerfield Menu, then select Add Substitution Powerfield

Name the powerfield Fiscal Period Month Name and give it a String data type. In the area labeled Data Substitution Table, click on the Source column drop down and select Fiscal Period Code, then click on the Collect Unique values button.
Doing this tells eThority that you want to substitute values in Fiscal Period Code with something else. Clicking on the Collect Unique Values button brings back all the values in the Fiscal Period Code field so that you can assign the values you want to substitute. Remember you are creating a new column – not changing the current one. Fill in the screen so that it looks like the following:
Then click on Test, then Save your powerfield, then refresh your databook. You should see a field called Fiscal Period Name with your substitution values.
Renaming and Rearranging Fields in a Report

In eThority you have the ability to rename and rearrange the order of the fields as they are displayed in your report. To do this, go to the View menu, then select Field Selector.

To rename a field, click on the Display Text of the field that you want to rename. This should highlight the contents of the field, such that you can change its contents. For this example, change the Object Code-Name field’s display text to be “Object Code” as shown below.

This renames the field to now be called Object Code.

To rearrange the order of the fields, select the field that you want to move, then click on the Move Up or Move Down button until the field appears where you want it to be. To get the fields in the same order as the 090 report, move the Current Month field to go before the FYTD field, and move the Account PF field to be under the Account Number field as shown below:
### Available Fields

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Data Request</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actual Transaction</td>
<td>F_Ledger</td>
</tr>
<tr>
<td>Budget Transaction</td>
<td>F_Ledger</td>
</tr>
<tr>
<td>Credit Transaction</td>
<td>F_Ledger</td>
</tr>
<tr>
<td>Encumbrance Transaction</td>
<td>F_Ledger</td>
</tr>
<tr>
<td>Full GL Key</td>
<td>F_Ledger</td>
</tr>
<tr>
<td>Payroll Transaction</td>
<td>F_Ledger</td>
</tr>
<tr>
<td>Source System</td>
<td>F_Ledger</td>
</tr>
<tr>
<td>Account City Name</td>
<td>KFS_GL_Account_A_K</td>
</tr>
<tr>
<td>Account Closed Indicator</td>
<td>KFS_GL_Account_A_K</td>
</tr>
<tr>
<td>Account ID Crosswalk Identifier</td>
<td>KFS_GL_Account_A_K</td>
</tr>
<tr>
<td>Account Create Date</td>
<td>KFS_GL_Account_A_K</td>
</tr>
<tr>
<td>Account Effective Date</td>
<td>KFS_GL_Account_A_K</td>
</tr>
<tr>
<td>Account Expiration Date</td>
<td>KFS_GL_Account_A_K</td>
</tr>
<tr>
<td>Account Fringe Benefit Code</td>
<td>KFS_GL_Account_A_K</td>
</tr>
<tr>
<td>Account Manager Name</td>
<td>KFS_GL_Account_A_K</td>
</tr>
<tr>
<td>Account Manager Username</td>
<td>KFS_GL_Account_A_K</td>
</tr>
<tr>
<td>Account Name</td>
<td>KFS_GL_Account_A_K</td>
</tr>
<tr>
<td>Account Offset Indicator</td>
<td>KFS_GL_Account_A_K</td>
</tr>
<tr>
<td>Account Postal Code</td>
<td>KFS_GL_Account_A_K</td>
</tr>
<tr>
<td>Account Type</td>
<td>KFS_GL_Account_A_K</td>
</tr>
<tr>
<td>Account Unit Code</td>
<td>KFS_GL_Account_A_K</td>
</tr>
<tr>
<td>Account Unit Name</td>
<td>KFS_GL_Account_A_K</td>
</tr>
<tr>
<td>Account Unit Type</td>
<td>KFS_GL_Account_A_K</td>
</tr>
<tr>
<td>Account Unit Unit Code</td>
<td>KFS_GL_Account_A_K</td>
</tr>
<tr>
<td>Account Unit Unit Name</td>
<td>KFS_GL_Account_A_K</td>
</tr>
<tr>
<td>Account Unit Unit Type</td>
<td>KFS_GL_Account_A_K</td>
</tr>
<tr>
<td>Account Unit Unit Unit Code</td>
<td>KFS_GL_Account_A_K</td>
</tr>
<tr>
<td>Account Unit Unit Unit Name</td>
<td>KFS_GL_Account_A_K</td>
</tr>
<tr>
<td>Account Unit Unit Unit Type</td>
<td>KFS_GL_Account_A_K</td>
</tr>
</tbody>
</table>

### Current DataBook Fields

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Display Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>University Fiscal Year</td>
<td>University Fiscal Year</td>
</tr>
<tr>
<td>Fiscal Period Code</td>
<td>Fiscal Period Code</td>
</tr>
<tr>
<td>Basic Accounting Category Code</td>
<td>Basic Accounting Category Code</td>
</tr>
<tr>
<td>FO Code</td>
<td>FO Code</td>
</tr>
<tr>
<td>Account Number</td>
<td>Account Number</td>
</tr>
<tr>
<td>Account PF</td>
<td>Account PF</td>
</tr>
<tr>
<td>Budget Summary 1 Code-Name</td>
<td>Budget Summary 1 Code-Name</td>
</tr>
<tr>
<td>Object Code-Name</td>
<td>Object Code</td>
</tr>
<tr>
<td>Actual Amount</td>
<td>Actual Amount</td>
</tr>
<tr>
<td>Beginning Balance</td>
<td>Beginning Balance</td>
</tr>
<tr>
<td>Current Month</td>
<td>Current Month</td>
</tr>
<tr>
<td>PTID</td>
<td>PTID</td>
</tr>
<tr>
<td>Encumbrances</td>
<td>Encumbrances</td>
</tr>
<tr>
<td>Remaining Balance</td>
<td>Remaining Balance</td>
</tr>
<tr>
<td>Fiscal Period Month Name</td>
<td>Fiscal Period Month Name</td>
</tr>
</tbody>
</table>

### Button Bar
- Add Field
- Add All
- Remove Field
- Remove All
- Move Up
- Move Down
- OK
- Cancel
Hiding Fields in a Report

To hide fields in a report, click on the Hide box next to the field that you want to hide from the report. Keep in mind if you hide a field you will not see its contents on the report. If you hide a field that is used in a group, the contents of the group header will be blank.

In this example, hide the Account Number, FO Code, Actual Amount and Fiscal Period Month Name field.
After clicking OK, refresh your report. You should no longer see the fields that you selected to hide. Also notice that since we had grouped our data using the Account Number field, the group header for that field is now blank.

To fix this problem, change the Account Number group to use the Account PF field instead. To remove a grouping, right click on the field that you want to remove, then select Delete Group.
Creating & Using Control Values

We have created filters and conditions in our report by hard coding the values we wanted to filter by into the report. What if you wanted to make the report dynamic, such that it prompts you for the values when you run the report. In eThority, this is possible by using Control Values. You first need to define your control values, then you can use them as filter criteria or condition criteria.

First, let’s create a control value for the fiscal period. This will be useful so that you don’t have to update all of your filters and powerfields each time the month changes.

To create a control value, click on the Powerfield menu, then select Configure Control Values.

The configure control values screen should appear. Click on the add button, then click on the Item 1 line that it creates.
This is where you specify the name, data type and default value of your control value. Those three values must be provided for the control value to be created. The column called “column” is if you base your control value against a field (which we won’t cover here). Enter the information as shown in the example below:

Then click on OK. You’ve just created a Control Value that you can use in your report.

There were two powerfields that we had created previously that would be good candidates to use this Fiscal Period Filter control value. We’re going to edit the Current Month and FYTD powerfields to use the control value so that you don’t have to modify the powerfield to view a different month’s report.

Click on the Powerfield menu, then select Edit Powerfields. Click on the Current Month powerfield, then click the Edit button. Click on the edit button under the For these Records heading.
When the Condition Builder window appears, right click on the Fiscal Period Code field and select Edit Filter.

Select Data Field on the screen that appears, then select Fiscal Period Filter from the drop down listing.
Then click on OK. The Condition Builder will be updated to show the default/current value of the control value in pink as the condition value.

Click OK, then Test and Save your Powerfield. Then Edit the FYTD powerfield to reference the Filter Period Filter control value as well.

Change existing condition to be as follows:
Then add another filter using Fiscal Period Code to exclude Fiscal Period 0. To exclude something in eThority, you do an equals condition, but click on the Exclude These From Result Set in the Filter Description area.

Your filter should now look like this:

Click OK, then test and save your Powerfield.
Edit the Encumbrances Powerfield as well to use the Control Value that you created.

Again, test and save your powerfield.

Then change the Beginning Balance powerfield to use your control value as well... Your filter builder should replace selecting the fiscal periods 0-11 from the pick list to look like the following:
**Entering Control Values**

You might be wondering how do you change the Control Value’s value once they are created and how do you get the report to prompt you to enter in control values upon opening a report.

To change the values of a control value once a report is open, click on the Powerfield menu, then select Enter Control Values.

The Control Value screen then pops up and prompts you for the values.
After hitting OK, you would then need to refresh your report to update values.

To get your report to prompt you to enter control values, you need to save your report with that option selected. Click on the File menu, then select Save (if Save is not available, click Save As)

Notice the Ask for Control Values option that is now available. Click on the box next to that option, then hit OK. The next time you open this report, it will present you with the control value screen prior to running the report.
For added practice, add in another Control Value for Fiscal Year Filter. Then add a filter on the main report builder to bring back only the transactions for the field called University Fiscal Year that equal the value entered into the control value. If you did it correctly, your control value window and your filter area of your report should look like the following two screen shots.
Group Functions

So now we have a report that’s grouped by Account and Budget Summary but notice there are no totals for each of the groups. To total the amounts on the grouped fields, you have to enable it on the fields that you want a calculation done.

eThority has several group function you can perform on a field assuming there is a group set up in your report. Right clicking on a field header brings up a popup menu with the available summary options for the field.

For the following fields, set the summary option to Sum so that you get totals on each of the group fields: Beginning Balance, Current Month, FYTD, Encumbrances, and Remaining Balance. Once that is done, your screen should look like the following:
Notice that the column headings where a summary was applied now look a little different. Depending on the summary option that was selected there will be a letter in a yellow circle indicating what kind of summary that is being applied. Since we have selected Sum, there’s a yellow circle with an S.

If you were to add more groups to the report, there will be a sum done at each of the groups that are added. To demonstrate this, add the Object Code field to the group listing, which should make your report now look like the following:

**Group Functions – Summary Only**

But what if we didn’t want to see all of the details under the object code? There’s a function in eThority that can just show the summary level data. Right click on the last group field in your Group window, then select Summary Only.
After refreshing your report, you should now see the following, which removes the details of the transactions.
Save / Save As

The Save and Save As function operate in the same way as most programs do. Save allows you to save the current report with the current filename (with the exception of when you create a databook based off a global derived databook). The Save As function allows you to save the report as a different name, thereby creating another report available for use.

The Save dialog box (shown above) has several fields.

- Name – The name of your databook/report
- Descr – Descriptive text associated with your databook/report. Appears to the right of the report name in the report listing
- ID – not used at this time
- Auto-Refresh Grid – selecting this option will make the report refresh itself each time a change is made to the databook/report.
- Expand All Groups – selecting this option will expand all of the groupings to display their contents upon opening the databook/report
- Ask for Control Values – selecting this option will present the Control Value screen on opening the report. This allows you to specify the control values prior to the report running.
Saving – Sharing a Databook/Report

The Sharing tab has options to save the report with other users. By default users of eThority can save the report as a User/Group type. The department and global types are reserved for data architects only.

A user/group databook/report can be shared with specific users. To do this, click on the Add User button. A screen similar to the below should appear:

From here, you can click on the box next to the email address of the person to share the report with them. Keep in mind that when you share a databook with a person they have rights to handle the report as if it were their own. This means they could delete your databook. We recommend that you share a copy of your databook/report with people so that you can have the original saved with you.
Saving – Library

The library tab on the save dialog allows you to save your databook in a different library (folder) than where the report originally was at. To change the library of the report, click on the Edit button, then select the library name you want the report to be in.

Keep in mind that if you use the save option and change the library of a databook, the databook will move to that new library. If you want to make a copy of the databook in a different library, use the Save as function.
Saving – Adding Notes/Comments to a Report

You can add in additional comments for a report on the Author/Notes tab of the Save dialog window. It can be freeform text. You can also datestamp your comments.
Printing a Report

Printing a report essentially creates a PDF file that you can then print locally. To print a report, click on the File menu, then select Print.

You can change the Report Title that will be printed at the top of the report by changing the Report Title text. You can also selectively print by grouped fields. The default will print the report in its entirety. Page Break between Groups will insert a page break between each change in the value of the groups. Print Page Footer prints page number and date information on each page of the report.

In order to use the Print function in eThority, be sure to have your popup blocker to allow popups from the eThority website. If popups are not enabled, you won’t be able to receive the PDF file to print.
NOTE: When printing reports, you won’t have control on how to fit your report onto a page. eThority will attempt to fit the entire report onto a page by shrinking the font size until the contents fit the page width. All reports are exported to PDF as a letter size document in landscape orientation. If your report is very wide, it is advised that you export the report instead. In the event that eThority cannot fit your report onto a page, it will output a blank page.
Exporting a Databook

Reports can be exported to several formats from eThority. Similar to the Print function, you can export just a section of the report, or in its entirety. See the screenshot for the listing of available output formats.

Note: for the Excel export format, there is a limit of 65,535 rows. If your report exceeds this line amount, you will need to export it to another format. This is a row limitation in Excel versions prior to 2007. In Excel versions from 2007, there is a 1,048,576 row limit. If your report exceeds the 65,535 row limit and Excel is selected, your export will be truncated. To determine the number of rows on your report, in the report view on the bottom right corner there is a total row count. Also, we recommend using the Microsoft Excel 2003 – Simple (XLS) export option as this version just exports the data without extra formatting.
Send (Schedule) a Databook

eThority has the ability to send/schedule reports to be delivered via email. You can select the type of file that is sent and even specify to not send an empty report.

The write to file option will not be used for users at this time. Currently, you can only use the Email option. Enter what you want to appear as the subject in the Subject Line field. Then you can click on Add eThority user to bring up a window to select the eThority users you want the report to be sent to.
Before clicking on OK, you have to click on the Schedule button near the middle of the page to set up when this report is going to be sent. Once you click on the schedule button, it will default to the Now option. You can pick from schedules that have been created by the reporting team. An example of possible schedules are shown below:
Additional Resources:
eThority Help System: https://ethority.reports.hawaii.edu/FlashHelp/eThority_Help_System.htm

UH eThority Training Resources:
http://www.hawaii.edu/kualifinancial/?page=eThority&showSubMenu=training